EOL Universal Printer™ (version 3.0)

Installation, Usage, and Troubleshooting Guide

(2nd Revision)
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Read This First!!!

If the following products and versions are currently in use, please read the below information.

EOL Desktop Manager™ (versions 1.x and 2.x) Users: if EOL Desktop Manager™ 1.x or 2.x is currently
in use, it MUST be upgraded to version 3.x before installing and using EOL Universal Printer™. Please
note that both products utilize the same database, management utility (THINssentials™ Management
Console), services, and COM objects.

EOL Universal Printer™ (versions 1.x and 2.x) Users: if EOL Universal Printer™ 1.x or 2.x is currently in
use, upgrading to version 3.x will invalidate the license key. Customers who have purchased their
license(s) after September 9", 2001 are eligible for a free upgrade to version 3.x. The new license key
replacements may be automatically generated by visiting http://www.99point9.com.

Compatibility with Previous Versions

Because version 3.x introduces advanced features such as page streaming and partial font embedding, it is
NOT backwards compatible with versions 1.x or 2.x. As such, upgrading the server component to 3.x will
necessitate a client-side upgrade as well.

In order to simplify the client upgrade process, it is recommended that the CAB-based client setup be
utilized. By simply embedding the following line into a Web page, the CAB file will download and install
automatically and silently:

<OBJECT CLASSID = “clsid:240EEE8D-91DB-4D74-A87E-671026601333"
CODEBASE="eolupcli.cab#VERSION=3,0,0,0"></OBJECT>

If eolupcli.cab resides in a folder other the one serving the current page, then the CODEBASE must
explicitly reference the full URL:

<OBJECT CLASSID = “clsid:240EEE8D-91DB-4D74-A87E-671026601333"
CODEBASE="http://www.mycompany.com/eolupcli.cab#version=3,0,0,0"></OBJECT>

Moreover the VERSION must match that of the EOLUP client inside the CAB file. For example, if version
3.0.2 is the most current version, the line becomes:

<OBJECT CLASSID = “clsid:240EEE8D-91DB-4D74-A87E-671026601333"
CODEBASE="http://www.mycompany.com/eolupcli.cab#version=3,0,2,0" ></OBJECT>



Introduction

Designed for Windows Terminal Services (NT 4.0 and 2000) and Citrix MetaFrame, EOL Universal
Printer™ (hereafter, EOLUP) is a single-driver printing solution aimed at simplifying the complexities that
plague any organization’s server-based printing needs. Like its predecessor (version 2.2.2), this new
version fully enables client-side printing using a single PDF-compatible print driver, and supports both ICA
and RDP 5.x Win32 clients without the need for the Adobe Acrobat Reader. Moreover, version 3.0
introduces a radically new approach to network-based printing by enabling ANY client device, regardless of
platform or operating system, to print to ANY shared network printer, regardless of make, model, or print
driver.

How It Works

Figure 1 depicts a typical network environment where EOLUP 3.0 has been deployed to fulfill the printing
needs of both LAN-connected and remote users. A Terminal Services farm hosts and serves a variety of
business applications to which LAN-based and remote clients connect using Microsoft RDP or Citrix ICA
client software.

Client-Side Printing

For client-side printing, EOLUP creates a PDF-compatible printer on the Terminal Server, enabling Terminal
Services and Citrix MetaFrame™ users to print to ANY client-side printer — anywhere, anytime.

Remote users could be home-based, mobile, or remote branch workers, or even outside partners requiring
access to shared applications. In all cases, the users’ computers are either equipped with locally attached
printers or rely on client-side network printers to fulfill the printing requirements. To provide printing support
from the Terminal Services side, the administrator simply installs EOLUP 3.0 on all the Terminal Services
servers. On the client side, the users are only required to download and install the small-footprint (1.5MB)
EOLUP 3.0 client software. Please note that, unlike other printing solutions available on the market, EOLUP
does not require the Adobe Acrobat Reader.

Network-Based Printing

LAN-connected users typically rely on shared network printers to fulfill their printing needs. These printers
are physically connected to either the print server’s I/O ports (i.e., LPT, COM) or the LAN infrastructure (i.e.,
Ethernet.) In both cases, the system administrator makes these printers available to users by configuring
and sharing corresponding printer resources on the designated print server. Figures 2-a, 2-b, and 2-c depict
two distinct printer configurations commonly found in almost any network.
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Figure 1 — EOL Universal Printer™ 3.0 offers a single-driver solution to all server-based printing needs, including client-side and network printing
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Figure 2-a — The administrator creates a shared printer resource for every physical printer.
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Figure 2-c — In this example, the HP LaserJet 4050 Series PCL is
physically connected to the LAN (i.e., Ethernet.) Users connect
and print to the printer by means of a shared printer resource
configured on the print server. The print server communicates with
the physical printer using the TCP/IP protocol.

Without EOLUP, Terminal Services users must manually browse the network and connect to the desired
shared printers. Moreover, the native print drivers of those printers must be pre-installed to the Terminal
Services servers by the system administrator. Because most organizations support a wide variety of
printer makes and models, managing a large set of print drivers and ensuring their stability and
compatibility with the Terminal Services platform can rapidly become a daunting task.

EOLUP 3.0 solves this complex challenge using a single-driver approach. For each existing network
printer (the “true” printer) defined on a particular print server, EOLUP creates and shares a “phantom”
Universal Printer counterpart on that same Print Server. As such, users connect and print their documents
to the Universal Printers instead of the original “true” printers. Once a particular document has been printed
to a Universal Printer, the print job is automatically forwarded to the corresponding “true” printer using its
native print driver. Figure 11 illustrates the process of printing from a server-based application to a
Universal Printer.
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Figure 3 — a client prints from a server-based application to a shared Universal Printer (phantom printer). The EOL
Universal Printer renders the print job and forwards it to the “true” print printer using its native print driver.



New UP 3.0 Features

Many valuable features have been added to this new version of EOLUP including:

1. Single-driver solution that satisfies all printing requirements, including client-side and network
printing.

2. For client-side printing, a new lightweight PDF viewer built into the EOLUP client. As such, Adobe
Acrobat Reader is no longer required on the client side.

3. The size of the EOLUP client download has been reduced to approximately 1.5 Megabytes. Five
separate client downloads are currently available:

eolupcli.exe: UP client

eolupcli_silent.exe: UP client - Silent install
eolupcli_ica32.exe: EOLUP client + Citrix ICA Full PN client
eolupcli_ica32a.exe: EOLUP client + Citrix ICA PN Agent
eolupcli_ica32t.exe: EOLUP client + Citrix ICA Web client
eolupcli.cab: CAB-based EOLUP client

Note: customers who wish to enable the auto-detection/download of the EOLUP client must add the
following line to their Web page:

<OBJECT CLASSID="clsid:240EEE8D-91DB-4D74-A87E-671026601333"
CODEBASE="eolupcli.cab#version=3,0,0,0"></OBJECT>

4. The EOLUP popup window that prompts the user to either print directly to client, save to disk, emalil
via SMTP or MAPI, has been implemented as a tab inside the properties of the printer to reduce the
number of steps/clicks required by the user to complete a EOLUP-based print operation. In order to
choose a particular delivery method, the user must invoke the printer selection box from within the
app. For example, when using Microsoft Word, click on File > Print > Universal Printer > Properties
> Delivery Options.

5. Higher print quality and accuracy through better PDF rendering. EOLUP v3.0 is based on the latest
PDF conversion engine which supports resolutions of up to 2400 dpi.

6. The property tabs (Configuration, Image Compression, Advanced Options) of the printer have been
simplified to only include the options and settings that are useful to the users.

7. Improved memory management and faster performance during server-side PDF conversion.



10.

11.

12.

13.

Reduced memory requirements when on the client side.

Font Embedding support. Font embedding is a feature that embeds non-standard server-side fonts
into the PDF-converted print job in the event that the client PC doesn't have those same fonts
installed locally. Generally, most documents are created with standard out-of-the-box Windows fonts
(i.e., Arial, Times New Roman, etc). In such cases, font embedding is not required because the
Windows client is expected to have those same standard fonts installed. However, many apps install
additional fonts that aren't necessarily available on the client PC. In those cases, font embedding is
necessary to ensure the accuracy of the print output. If print jobs with garbled characters are ever
encountered, it is most certainly a case of font embedding. Check the font embedding option
available at print time from the Advanced Options tab in the EOLUP properties.

Support for Page Streaming means that users no longer have to wait for the entire PDF-converted
print job to be received before printing can begin. With version 3.0, pages are streamed down one by
one to the client and automatically sent to the printer as they are being received.

Platform-specific print driver versions for Windows NT 4.0 Terminal Server and Windows 2000 Server.
When installing EOLUP v3.0 to a Windows NT 4.0 Terminal Server (WTS), a kernel-mode version of
the driver is installed (WTS does not support user-mode print drivers). In contrast, a user-mode
version of the print driver is installed to a Windows 2000 Terminal Services server. The advantages of
a user-mode driver is enhanced stability (no blue screens) and higher performance.

Support for pass-through sessions. Users can launch ICA or RDP sessions from within ICA or RDP
sessions and take full advantage of EOLUP.

The client settings are now stored in an ini file (eolupclint.ini) that resides in the Windows directory.
Moreover, the client menu options and the system tray icon can selectively be hidden or shown. The
client menu options are:

Print to default printer

Prompt for printer

Preview job before printing

Sample eolupcint.ini:

*kkkkkk *% *k%k *% *kkkkkkk *% *k%k *% *kkkkkkk *% *k%k *% *kkkkk

[Settings]

Default=1

Hide1=0 ; 0 or 1 shows or hides the "preview job before printing" option
Hide2=0 ; 0 or 1 shows or hides the "prompt for printer" option

Hide3=0 ; 0 or 1 shows or hides the "print to default printer" option
Hide4=1; 0 or 1 shows or hides the "passthrough mode" option
NoSysTraylcon=0 ; 0 or 1 shows or hides the system tray icon

*kkkkkk *% *k%k *% *kkkkkkk *% *k%k *% *kkkkkkk *% *k%k *% *kkkkk




Note: to support pass-through (see item 8), the UP client must be installed on both the client PC and
the pass-through server(s) from which additional ICA or RDP sessions will be launched to other
servers. In this case, the Default and NoSysTraylcon options in eolupcint.ini (on the pass-through
server) should be as follows:

[Settings]

Default=4

Hide1=0 ; 0 or 1 shows or hides the "preview job before printing" option
Hide2=0 ; 0 or 1 shows or hides the "prompt for printer" option

Hide3=0 ; 0 or 1 shows or hides the "print to default printer" option
Hide4=1 ; 0 or 1 shows or hides the "passthrough mode" option
NoSysTraylcon=1 ; 0 or 1 shows or hides the system tray icon

This will automatically enables EOLUP pass-through mode when an ICA or RDP connection is
launched from a server session to another server.

14. A new utility, eoldfprn.exe, is provided that automatically configures the EOLUP as the default for all
Terminal Server and MetaFrame users.

15. Full support for ICA 3.0 and RDP 5.0.



Installing EOL Universal Printer™

Terminal Services Component

Download and install EOLUPSVR.EXE to your Terminal Services server(s). When asked whether “this
server is a designated Universal Print Server,” click NO (see figure 4.) The installation program performs
the following functions:

Installs the EOL Universal Printer Driver.

Installs the EOLUP Port Monitor.

Creates the Universal Printer.

Installs and automatically starts the EOL Universal Printer service.

Installs and automatically starts the EOL Desktop Management service.

Adds EOLDM.EXE (the Desktop Management client) to the AppSetup registry value under
HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon.

Grants a 30-day trial license.
Generally, it is not necessary to reboot the server upon completing the installation, unless older versions of
shared components (i.e., mfc42.dll, etc) were found on the server. However, if the “EOL Universal Printer”

and “EOL Desktop Management” services start successfully upon completing the installation, users can
immediately start using EOLUP.

Universal Print Server Component

Download and install EOLUPSVR.EXE to your print sever(s). When asked whether “this server is a
designated Universal Print server,” click YES (see figure 4). The installation program performs the
following functions:

Installs the EOL Universal Printer Driver.

Installs the EOLUP Port Monitor.

Installs and automatically starts the EOL Universal Printer service.



The Universal Print Server component can be installed onto as many print servers as desired
without requiring additional licensing as only Terminal Services servers require valid licenses. For
further information about licensing, check the section titled “Licensing EOL Universal Printer™”.

Welcome to the Install5hield Wizard for EOL
Univerzal Printer Server

The InstallShield® Wizard will ingtall EOL Urniversal Printer
Server on pour computer. To continue, click Mest,

]

@ Is this server a designated Universal Prink Server?

Yes Mo

¢ Back | M et = I Caricel

Figure 4 — Answer NO when installing to a Terminal Server. Answer YES
when installing to a print Server.




Client Component

The client component is ONLY required for client-side printing. Both ICA 3.0 and RDP 5.x are supported
on Win9x/Me, Windows NT 4.0, 2000, and XP client platforms. Support for RDP is only available when
connecting to Windows 2000 Terminal Services because Windows NT 4.0 Terminal Server does not
support the use of 3" party virtual channels. Before installing the EOLUP client software, please ensure
that at least the ICA (6.x or above) or the RDP 5.x Win32 client software is already installed to the client
PC. Finally, download and install EOLUPCLI.EXE. The installation program performs the following
functions:

Copies and registers the Universal Printer's ICA and RDP 5.x client components to the user’s PC.

Configures the ICA and RDP 5.x clients to initialize the Universal Printer’s virtual channel driver
upon launching ICA and RDP 5.x connections.

Upgrading from Previous Versions

Server Component

Note: if you are upgrading from a previous version of EOLUP, please refer to the section titled Licensing
EOL Universal Printer™ before performing the upgrade.

Uninstall the previous version of EOLUP.
Set the startup type of the Print Spooler service to Manual.
Reboot the server.

Delete eoluppdf.dll, eolupui.dil and eoluppdf.txt from %SystemRo00t%\System32\
Spool\Drivers\W32x86\2.

Start the Print Spooler service and set it start type back to Automatic.

Install the new version of EOLUP.

Client Component

Ensure that no active ICA or RDP connections exist on the client PC.

Install the new version of the EOLUP client.

Reboot the client PC.



Client-Side Printing With EOL Universal Printer™

Upon launching and ICA or RDP 5.x connection, the Universal Printer icon appears in the client’s system
tray (printer + globe). Properly configured clients can now print to the Universal Printer from within their

server-based applications as shown in figure 5.

- ]

—Prinker
Mame: ‘™ Lniversal Printer Froperties |
Skatus: Idle
Twpe: EQL Universal Prinker Driver
where: ECQLLP: [ Print ka file
arnmmenk:
~Page range r_opies
&= al Mumber of copies: |1 E‘
" Current page € Selection
" Pages: I ¥ Collate
Enter page numbers andfor page ranges
separated by commas. Faor example, 1,3,5-12
200
Frint what: IDDI:LImEHt j Pages per sheet: |1 page j
Prirt: I.ﬁ.ll pages in range j Scale ta paper size: IN::: Scaling j
Qpkions, .. | Ik I Close |

Figure 5 — Through the use of the EOLUP, ICA and RDP 5.x clients may print
any server-side document to any client-side printer.

Moreover, by clicking the Properties button, users can access the properties of the Universal Printer and
choose various print and delivery options (see figures 6 —a, b, c, d).
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Figure 6-a — The Configuration Tab.
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Figure 6-b — The Advanced Options Tab.
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Figure 6-c — The Delivery Options Tab.
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Figure 6-d — The Image Compression Tab.



Delivery Options

Print directly to client: when the user chooses this option, the document is PDF-converted and
compressed, and then streamed down to the client PC. Depending on the currently set client option, the
print job is either previewed before printing or sent to the client’s default printer, or the user is prompted to
choose the destination printer. Figure 7 illustrates the three possible client-side options.

fbout

Print ko default prinker
Prompk For prinker
v Presiew job before printing

E% 15 am

Figure 7 — In the system tray, click on the Universal
Printer icon (printer + globe) to set the desired client
preference.

Send Print Job Using E-Mail Program: when users choose this option, the server-side MAPI-compliant
email software (MS Outlook, Lotus Notes, Novell GroupWise, Eudora, etc) is automatically invoked and the
PDF-converted print job attached. Next, the user must choose the intended e-mail recipient(s) and
optionally populate the Subject line (see figure 8).
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Figure 8 — Sending a print job as an e-mail attachment



Send Print Job Using Internet Mail Settings Below: when users choose this option, the PDF-converted
print job can be emailed using SMTP. No email client is necessary in this case. Instead, a mail server that
accepts SMTP relay requests is all that is required. A user must key in his/her email address, the
recipient’'s email address, a subject line, and the name of the file attachment (see figure 6-c). The IP
address or FQDN of the SMTP server can either be keyed in by the user or pre-configured by the
administrator.

Save to Disk: when users choose this option, they simply specify the path name of the PDF-converted
print job. Consequently, the PDF file can either be opened for viewing using Acrobat Reader or stored for
future access.

Note: Only the Print directly to client option requires the Universal Printer client on the user’'s PC.

Customizing the Delivery Options Tab

Administrators have total control over which delivery options they make available to users.

Policy Template

A policy template called EOLUP.ADM is copied to the server during the installation of the EOLUP server
component. This template can be used with either Windows NT 4.0 domain policies (figure 9-a) or Active
Directory Group Policy Objects (figure 9-b).

Note: when used in conjunction with Group Policy Objects (GPO), the policy template must be imported by
right-clicking on Administrative Templates and choosing the Add/Remove Templates... option (figure 9-
b). Also, right-click on Administrative Templates, choose View, and uncheck Show Policies Only and
Show Configured Policies Only. Finally, expand the Emergent OnLine node and configure the various
delivery options as desired (figure 9-c).
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Figure 9-a — Delivery options can be controlled on a per user or
group basis using a domain policy in conjunction with the
EOLUP policy template.
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Figure 9-b - Delivery options can be controlled on a per-user or group basis using Group
Policy Objects (GPO) in conjunction with the EOLUP policy template.
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Figure 9-c — The configurable delivery options are accessible by accessing the EOL
Universal Printer node Administrative Templates > Emergent OnLine.

Scripting

Savvy system administrators often exploit the power of scripting to effect user environment settings during
logon. Most of these settings are registry values written to each user’s own registry hive (HKCU). As such,
EOLUP was designed to allow system administrators to control the availability of the various EOLUP
delivery options by means of scripting. The configurable registry key and values are:

Sub-key: HKCU\Software\Emergent OnLine\Universal Printer

Value name: DeliveryOption

Value type: REG_DWORD

Description: specifies the default delivery option

Possible values: 1 (print directly to client), 2 (MAPI), 3 (SMTP), 4 (save to disk)

Value name: Attachment

Value type: REG_SZ

Description: the name of the file attachment to use when e-mailing the print job
Possible values: any valid file name (.pdf extension recommended)



Note: the user can override this option at print time

Value name: Subject

Value type: REG_SZ

Possible values: no restrictions

Description: specifies the string to use in the e-mail subject field
Note: the user can override this option at print time

Value name: FilePath

Value type: REG_SZ

Description: the file name to use with the save-to-disk option
Possible values: any valid file name (.pdf extension recommended)
Note: the user can override this option at print time

Value name: RecipientAddr

Value type: REG_SZ

Description: the recipient’'s e-mail address (for use with the SMTP option)
Possible values: any valid e-mail address (i.e., jdoe@acme.com)

Note: the user can override this option at print time

Value name: RecipientName

Value type: REG_SZ

Description: the e-mail recipient’s full name (for use with the SMTP option)
Possible values: any valid e-mail address (i.e., John Doe)

Note: the user can override this option at print time

Value name: SenderAddr

Value type: REG_SZ

Description: the sender’s e-mail address (for use with the SMTP option)
Possible values: the user’'s own e-mail address (i.e., jdoe@acme.com)
Note: the user can override this option at print time

Value name: SenderName

Value type: REG_SZ

Description: the sender’s full name (for use with the SMTP option)
Possible values: the user’s own full name (i.e., John Doe)

Note: the user can override this option at print time

Value name: SMTPServer

Value type: REG_SZ

Description: the IP address or Fully Qualified Domain Name (FQDN) or the SMTP relay server (i.e.,
mail@acme.com)

Possible values: any SMTP server capable or relaying e-mail requests

Note: the user can override this option at print time



Sample VB Script:

Dim oShell

Set oShell = CreateObject("Wscript.Shell™)
oShell.RegWrite "HKCU\Software\Emergent OnLine\Universal Printer\ DefaultOption”, 1, "REG_DWORD"
oShell.RegWrite "HKCU\Software\Emergent OnLine\Universal Printer\ SMTPServer", “mail.acme.com”, "REG_SZ"

Client Options

As shown in figure 10-a, a system tray icon on the client side indicates that the EOLUP client is currently
active and ready to receive print jobs from the server. The user can configure the EOLUP client by clicking
on the icon and choosing one of the three options:

- Print to default printer: the print job is automatically redirected to the client’s default printer.

- Prompt for printer: the Printer Selection box appears and the user is prompted to choose the
desired destination printer.

- Preview job before printing: the print job is opened in preview mode on the client. The user may
then choose to send it to a destination printer, save it to disk, or e-mail it (see figure 10-b).

fbout

Print ko default prinker
Prompk For prinker

v Presiew job before printing

E% 15 am

Figure 10-a — In the system tray, click on the
Universal Printer icon (printer + globe) to set the
desired client preference.
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Figure 10-b — The EOLUP Viewer.




Network Printing With EOL Universal Printer™

In addition to client-side printing, EOLUP 3.0 enables driver-independent printing to any shared printer on
the network. For each existing network printer (the “true” printer) defined on a particular print server,
EOLUP creates a shared a “phantom” Universal Printer counterpart on that same Print Server. As such,
users connect and print their documents to the Universal Printers instead of the original “true” printers.
Once a particular document has been printed to a Universal Printer, the print job is automatically forwarded
to the corresponding “true” printer using its native print driver. Figure 11 illustrates the process of printing

from a server-based application to a Universal Printer.

. Universal Printer (shared)
UNC Name: \PS1\HP LaserJet 4050 Series PCL (UP)

ICA or RDP Session . . . .
Driver Name: EOL Universal Printer Driver

Application
o

]

—

"True" Printer (shared)

UNC Name: \\PS1\HP LaserJet 4050 Series PCL
Driver Name: HP LaserJet 4050 Series PCL

Print Server
(PS1)

Client

Terminal
Server

Figure 11 — a client prints from a server-based application to a shared Universal Printer (phantom printer). The EOL Universal
Printer renders the print job and forwards it to the “true” print printer using its native print driver.

EOLUP 3.0 stores all defined Universal Printers in a physical database. This database must be accessible
to all print servers and Terminal Services servers in the enterprise. Any ODBC-compliant database should
work fine with EOLUP, although only Microsoft SQL 7.0/2000 and Access have been tested at this time.
To reduce network traffic, a Windows NT/2000 service called “EOL Desktop Management” is installed on
every Terminal Services server. This service is tasked with creating a local database cache that mirrors
the central database. Periodically, the “EOL Desktop Management” service checks the central database
for new updates and refreshes the local database cache accordingly. By default, the refresh period is set
to 2 minutes, but can be adjusted as desired.

Note: the EOLUP client is NOT required for network printing.



Requirements

Existing Windows NT 4.0 or 2000 print server(s).
One or More Terminal Services server with or without Citrix MetaFrame (or other 3" party add-on).

MDAC 2.6 SP1 (or higher) on all print servers and Terminal Services servers. MDAC is
downloadable from http://www.microsoft.com/data.

An ODBC-compliant relational database management system. In the case of Microsoft Access, the
database file must reside on a central server in a shared folder (i.e., \\servername\sharename) that
is accessible to all print servers and Terminal Services servers.

Configuring a Microsoft Access Data Source

First Server and One-Time Database Setup

The below steps MUST be performed on ONE server ONLY. This server can be either a print server or
Terminal Services server onto which the EOLUP 3.0 server component has already been installed.

Create a shared folder on a central file server (i.e., C:\THINssentials). This folder must be
accessible to all print servers and Terminal Services servers using a UNC path (i.e.,
\\FS1\THINssentials).

Invoke the ODBC Data Sources Administrator tool by clicking Start > Administrative Tools >
Data Sources (ODBC). In the case of Windows NT 4.0 Server, invoke Control Panel and launch
the ODBC Data Sources applet.

Click on the System DSN tab and create an ODBC data source as illustrated in figures 12(a, b, c, e).

Launch the THINssentials™ Management Console and configure it to use the newly created
ODBC data source as illustrated in figures 12(f, g, h).

Close the THINssentials™ Management Console.

Remaining Servers

The below steps must be performed on the remaining print servers or Terminal Services servers onto
which the EOLUP 3.0 server component has already been installed.



Invoke the ODBC Data Sources Administrator tool by clicking Start > Administrative Tools >
Data Sources (ODBC). In the case of Windows NT 4.0 Server, invoke Control Panel and launch
the ODBC Data Sources applet.

Click on the System DSN tab and create an ODBC data source as illustrated in figures 12(a, b, d,
e).

Launch the THINssentials™ Management Console and configure it to use the newly created
ODBC data source as illustrated in figures 12(f, h).

Create New Data Source ﬂ

Select a driver for which you want bo zet up a data source.

N | i il
Diriver do Microzoft dB ase [*.dbf) J
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Eazpzoft IBE ODBC

Microzoft Access Driver [*.mdb]
Microzoft Access-Treiber [ mdb]
Microzoft dBase Driver [*.dbf]

Microzoft dBase WFP Driver [*.dbf]
bimreenbt AR nea Traibar % ARE
il 1

T e e = T g e

T".'h.
1

¢ Back I Firizh I Cancel

Figure 12-a — Choose the Microsoft Access Driver.
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Figure 12-b — Fill in the Data Source Name and Description fields.
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Figure 12-c — Click the “Create...” button (see figure 12-b) and populate the
Database Name field with the full UNC path of the Microsoft Access database to

be created.

database name. Click “OK” to create the database.

EOLDM.MDB (EOL Desktop Management) is the recommended
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Figure 12-d — for all subsequent servers click the “Create...’
button (see figure 12-b) and populate the Database Name
field with the full UNC path of the Microsoft Access
database. Upon clicking “OK”, the database will be
automatically created.
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Figure 12-e — Click “OK” to complete the creation of the ODBC data
source.
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Configuring a Microsoft SQL Server Data Source

Microsoft SQL Server

Launch the SQL Enterprise Manager and create a new database as shown in figures 13-a, b, c, d.

First Server and One-Time Database Setup

The below steps MUST be performed on ONE server ONLY. This server can be either a print server or
Terminal Services server onto which the EOLUP 3.0 server component has already been installed.

Invoke the ODBC Data Sources Administrator tool by clicking Start > Administrative Tools >
Data Sources (ODBC). In the case of Windows NT 4.0 Server, invoke Control Panel and launch
the ODBC Data Sources applet.

Click on the System DSN tab and create an ODBC data source as illustrated in figures 14(a, b, c, d,
e, f).

Launch the THINssentials™ Management Console and configure it to use the newly created
ODBC data source as illustrated in figures 12(f, g, h).

Close the THINssentials™ Management Console.

Remaining Servers

Invoke the ODBC Data Sources Administrator tool by clicking Start > Administrative Tools >
Data Sources (ODBC). In the case of Windows NT 4.0 Server, invoke Control Panel and launch
the ODBC Data Sources applet.

Click on the System DSN tab and create an ODBC data source as illustrated in figures 14(a, b, c, d,
e, f, g, h).

Launch the THINssentials™ Management Console and configure it to use the newly created
ODBC data source as illustrated in figures 12(f, h).

Close the THINssentials™ Management Console.
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Figure 13-a — Microsoft SQL Server Enterprise Manager. Right-click on the Databases node and
choose the “New database...” option.
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Figure 13-b — Create a database named THINssentials with an initial size of
10MB as shown above.
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Figure 13-c — Right-click on the Security > Logins node in
the SQL Enterprise Manager and choose the “New login”
option. Create a new login named THINssentials and set its
default database to THINssentials (see 13-a, b).
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Figure 13-d — Choose the Database Access tab and
highlight the THINssentials database. Check the public and
db_owner checkboxes.
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Figure 14-a — Choose the Microsoft SQL Server Driver.
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Figure 14-b — Fill in the Name and Description fields. From the Server
dropdown box, choose the database server (see figure 13-a) hosting the
newly created THINssentials database. Click Next.
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Figure 14-c — Fill in the Login ID and Password fields using the credentials
of the THINssentials login account (see figure 13-c). Click the “Client
Configuration...” button and choose the TCP/IP network library option.
Click Next.
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Figure 14-d — Check the “Change the default database to” option and
choose the THINssentials database from the dropdown box. Click Next.
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Figure 14-e — Accept the default settings and click Next.
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Figure 14-f — Click the “Test Data Source...” button to
run the connectivity tests. Verify that the tests have
completed successfully.



Configuring Network Universal Printers

Simply launch the THINssentials™ Management Console from any EOLUP-enabled print server
or Terminal Services server. Because all servers are configured to point to the same central
database, it doesn’'t matter which server you launch the THINssentials Management Console from

(see figure 15).

Click the Printer Management Tab.

Click the Add Item toolbar button on the Printer Management Tab.
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Figure 15 — The THINssentials Management Console.




In the New Printer configuration window (see figure 16), click the Printer Type dropdown box and
choose the Network Universal Printer option.

Click the Server Name dropdown box and choose the desired EOLUP-enabled print server.

Click the Printer Name dropdown box and choose a printer for which a Network Universal Printer
counterpart is to be created. The Universal Printer Name field will be automatically populated with
the recommended name for the Network Universal Printer.

Upon clicking OK, the Network Universal Printer will be automatically created and shared on the
target print server. Moreover, the Network Universal Printer permissions list will be set identically to

the native printer.

Repeat the above steps for all the desired printers and print servers.

= Mew Printer -0 x|
—Printer Type
Metweork Universal Printer j

—Prirter Parameters

Server Mame:

| PS j
Printer Marme:
| HP Laszer.Jet 4050 PS j

Univerzal Printer Mame:
IHFl Lazerdet 4050 PS (UP)

(0],9 Cancel

Figure 15 - The New Printer
configuration window.

Assigning Network Universal Printers

In figure 17, four Network Universal Printers have been created for illustration purposes. Next, these
Network Universal Printers will be assigned so that network printer connections will be automatically
established when users logon to the Terminal Services servers. With EOLUP, Network Universal Printers
may be assigned to individual users, groups, client device names, and client device IP addresses.



In the left-hand pane, simply click one of the four toolbar buttons (Add User, Add Group, Add IP

Address, Add Client) or right-click any node in the tree and click the desired “Add” option (figure 16).

Choose the desired domain user accounts and groups to whom Network Universal Printer will be

assigned (figure 17).

Choose the desired client IP address or address range (wildcard are permitted. Figure 18).

Choose the desired client name or name range (wildcard are permitted. Figure 19).
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Figure 16 — A configuration depicting four Network Universal Printers. There is no limit to the number of
Network Universal Printers that may be created.
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Figure 17 — Add domain users and groups.
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Figure 19 — Add a single client name
or client name range. Wildcards are
also supported (i.e., Winterm*).
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Figure 20 — Highlight a particular user, group, IP address/range, or client name/range. Click the

Printer Management tab in the right-hand pane and make the desired printer assignments by
clicking the Assign toolbar button or right-clicking each individual printer and choosing the Assign

option.




Applying Printer Assignments Cumulatively

By default, when users logon to Terminal Services sessions, EOLUP applies Network Universal Printer
assignments on a first-match basis. The tree is systematically parsed in the downward direction
looking for the first matching user name, group membership, client device name, or client device IP
address. Once the first match is found, the assigned Network Universal Printers are applied the user’s
profile. Any other potential matches are subsequently ignored.

If so desired, Network Universal Printer assignments can be configured to apply cumulatively. The tree
is systematically parsed in the downward direction looking for all user name, group membership, client

device name, or client device IP address matches. Once all the matches are identified, the cumulative

list of Network Universal Printers is subsequently applied to the user’s profile.

To apply network printer assignments cumulatively, click File > System Settings in the
THINssentials™ Management Console and click the “Apply network printer mappings
cumulatively” in the General tab (figure 21).
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Figure 21 — The System Settings Window



How EOLUP Applies Printer Assignments

When EOLUP is installed onto a Terminal Services server, the setup program adds EOLDM.EXE to the
AppSetup registry value under HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon.
When users logon to a Terminal Services session, EOLDM.EXE connects to the database and applies all
printer assignments associated with the user account name, group memberships, client device name, and
client device IP address. Immediately upon applying the printer assignments, EOLDM.EXE terminates.

Printer assignments may be applied cumulatively or on a first-match basis as described in the previous
section.

Assigning Network Universal Printers through Citrix MetaFrame XP

If so desired, MetaFrame XP’s printer management capability may be used to assign Network Universal
Printers to users during logon. In this case, EOLDM.EXE may be removed from the AppSetup registry
string.

To assign Network Universal Printers to MetaFrame XP users, simply import the shared Network Universal
Printers through the Citrix Management Console. This can be accomplished by right-clicking the Printer
Management Node and choosing the Import Print Server option (figure 22). The imported Network
Universal Printers may then be assigned to domain users and groups.
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Figure 22 — The Citrix Management Console.



Integration with EOL Desktop Manager™

If EOL Desktop Manager™ 1.x or 2.x is currently in use, you MUST upgrade to version 3.x before installing
and using EOL Universal Printer™. Both products utilize the same database, management utility
(THINssentials™ Management Console), services, COM objects, and the EOLDM.EXE component.



Troubleshooting Guidelines

The purpose of this section is to provide system administrators and integrators with the necessary
guidelines for troubleshooting the operation of the EOLUP. Both server and client components are covered
in this document.

Server-Side Troubleshooting

The EOLUP v3.0 Server setup program (eolupsvr.exe) installs the following files and services as follows:

EOLUP.EXE: EOLUP service. This file is copied to the System32
directory. It is dated 8/14/2002 12:16p.

EOLUPMON.DLL: EOLUP port monitor. This file is copied to the
System32 directory. It is dated 8/14/2002 12:16p.

EOLUPPDF.DLL: EOLUP print driver (PDF conversion engine). This file is copied to
%SystemRo00t%\System32\Spool\Drivers\W32x86. It is dated 8/14/2002 12:16p.

EOLUPUIL.DLL: EOLUP print driver user interface. This file is copied to
%SystemRo00t%\System32\Spool\Drivers\W32x86. It is dated 8/14/2002 12:16p.

EOLUPPDF.TXT: EOLUP driver data file. This file is copied to
%SystemRo00t%\System32\Spool\Drivers\W32x86. It is dated 11/11/2001
9:24p (unimportant).

EOLUPS2D.EXE: EOLUP save-to-disk sub-system. This file is copied to %SystemRoot%\System32 and
dated 8/14/2002 12:16p.

EOLUPMAPI.EXE: EOLUP Mail API sub-system. This file is copied to %SystemRoot%\ System32 and
dated 6/18/2001 1:11p.

EOLLM.DLL: License Manager. This component is shared by various EOL THINssentials products. It is
copied to %SystemRoot%\ System32 and dated 6/18/2001 1:11p.

REG.OCX: EOL Registry interface. This component is shared by various EOL THINssentials products. It is
copied to %SystemRoot%)\ System32 and dated 6/28/2001 7:48p.

FLP32X20.0CX: Fairpoint Listbox control. This component is shared by various EOL THINssentials
products. It is copied to %SystemRoot%\ System32 and dated 6/28/2000 3:21p



EOLSVCMGR.EXE: EOL THINssentials Service Manager. This shared component is for managing product
license keys and starting/stopping various services. The latest version is downloadable from ftp.go-
eol.com/public/ thinssentials/shared. The current version is 2.05.

EOLDEFPRN.EXE: General-purpose EOL utility for setting the user’s default printer. This tool is
independent of EOLUP and can be freely distributed.

Example: to set the users’ default printer to the Universal Printer, add the following line to the logon script:
EOLDEFPRN “Universal Printer”.

EOLDPUSR.CMD: Sample script calling EOLDEFPRN.EXE to establish the Universal Printer as the
default printer for a group called “UP Users”. It is recommended that you copy this file to
%SystemRoot%\Application Compatibility Scripts\Logon and add the statement, Call EOLDPUSR.CMD, to
the end of USRLOGN1.CMD.

Upon copying the above files to their appropriate locations, the setup program executes the command
“EOLUP —i". This command performs the following tasks:

Starts the Print Spooler service if stopped.

Installs the EOLUP Driver by calling the AddPrinterDriver Windows API function. This automatically
copies EOLUPPDF.DLL, EOLUPUIDLL, and EOLUPPDF.TXT from %SystemRo00t%\System32\
Spool\Drivers\W32x86 to %SystemRoo0t%\System32\Spool\Drivers\ W32x86\2. Please note that
unless the files already exist in %SystemRo00t%\System32\ Spool\Drivers\W32x86, the
AddPrinterDriver call will fail.

Creates the “Universal Printer” in the Printers folder of the server, provided that the print driver was
installed successfully.

Installs and starts the “EOL Universal Printer Service”.



Troubleshooting Tips

If the server administrator mistakenly deletes the “Universal Printer” from the Printers folder, he/she can
perform the following tasks to resolve the problem:

Execute: EOLUP —u (ensure that the Services applet is closed during this operation).
Verify that EOLUPPDF.DLL, EOLUPUI.DLL, and EOLUPPDF.TXT still exist in

%SystemRo00t%\System32\Spool\Drivers\W32x86. Otherwise, copy them from
%SystemRo00t%\System32\Spool\Drivers\W32x86\2.

Execute: EOLUP -i

Verify that all versions of the files are consistent with the aforementioned versions (see “Server
Components” section).

Verify that the license key is still valid and permanent.

Verify that the “EOL Universal Printer Service” has started.

Client Components

The EOLUP client copies the following files to a Windows 9x/Me, NT 4.0, Win2K, or WinXP client PC:

EOLUPCLNT.EXE: EOLUP client executable. This file is copied to the Windows\System (or
WINNT\System32) directory. The file version is 3.0.

VDRDPUP.DLL: EOLUP Virtual Channel Driver for Microsoft RDP 5.x client support. This file is copied to
the Windows\System or (WINNT\System32) directory.

VDICAUP4.DLL: EOLUP Virtual Channel Driver for Citrix ICA Win32 client version 4.x support. This file is
copied to the Citrix ICA client directory.

VDICAUPG6.DLL: EOLUP Virtual Channel Driver for Citrix ICA Win32 client version 6.x support. This file is
copied to the Citrix ICA client directory. Note: this virtual channel driver supports Citrix ICA client versions
6.0 and above.



Below are additional notes concerning the client setup:

The location of the Citrix ICA client directory (installation path) is determined by examining the path
specified in the “Default” registry value of the following sub-key:

HKEY_CLASSES_ROOT\WinFramelCA\Shel\Open\Command

The version of the Citrix ICA client is determined by examining the VERSION.DAT file in the client
directory. Depending on the version of the client (4.x or 6.x), either VDICAUP4.DLL or
VDICAUPG6.DLL is copied to the ICA client directory. The MODULE.INI file is consequently modified
for purpose of loading the virtual channel driver when launching ICA connections.

Future upgrades of the Citrix ICA client will overwrite the existing EOLUP-modified MODULE.INI.
However, shortly following a new release of the ICA Win32 client family, Emergent OnLine always
posts updated bundles of the ICA Win32 and EOLUP clients. As such, administrators are
recommended to download the latest EOLUP-enabled ICA Win32 clients from Emergent OnLine’s
Web site (http://www.99point9.com).

For reference purposes, a sample module.ini is shown below. The EOLUP-specific modifications are

outlined in oversized bold typeface. Those are the modifications that the EOLUP client setup
program makes to the various sections of Module.ini.

[ICA 3.0]

DriverName = WDICA30.DDL

DriverNameWin16 = WDICA30W.DLL

DriverNameWin32 = WDICA30N.DLL

ProtocolSupport = Modem, RFrame, Frame, Reliable, Encrypt, Compress
VirtualDriver =Thinwire3.0, ClientDrive, ClientPrinterQueue,
ClientPrinterPort,

Clipboard, ClientComm, ClientAudio, ClientManagement, LicenseHandler,

ProgramNeighborhood,VFrame, TWI,ZL_FONT,zLC, ICACTL,VDICAUP
BufferLength = 2048

XmsReserve =0

LowMemReserve = 51200

ConnectTTY =On

ConnectTTYDelay = 1000

Reducer = ICAREDU.DDL

ReducerWinl1l6 = ICAREDUW.DLL

ReducerWin32 = ICAREDUN.DLL

VDICAUP =vdicaup6.dll

[VirtualDriver]
Thinwire3.0 =
ClientDrive =
ClientPrinterQueue =
ClientPrinterPort =
Clipboard =
ClientComm =
ClientAudio =

TWI =



ClientManagement =
LicenseHandler =
ProgramNeighborhood =
VFrame =

ZL_FONT =

ZLC =

ICACTL =

VDICAUP =

In addition, the following section is added to the end of MODULE.INI:

[VDICAUP]
DriverNameWin32= vdicaup6.dll

Support for the RDP 5.0 (and above) protocol is provided through the VDRDPUP.DLL virtual
channel driver which is copied to Windows\System (Win9x) or WINNT\System32 (NT 4.0/2000). The
virtual channel driver is automatically loaded upon launching an RDP 5.0 connection. The UP client
setup program registers this driver in the registry under the sub-key,
HKCU\Software\Microsoft\Terminal Server Client\Default\AddIns, and makes the following registry
modifications:

New sub-key: VDRDPUP

New value name: Name (REG_SZ)
New value: VDRDPUP.DLL

Troubleshooting Tips

Verify that EOLUPCLNT.EXE is in the Windows\System (or WINNT\System32 for Windows NT 4.0,
2000, and XP clients).

Verify that the virtual channel driver (VDICAUP4.DLL or VDICAUPG6.DLL) is present in the Citrix ICA
client directory and is consistent with the version of the installed ICA client.

Verify that MODULE.INI contains the necessary EOLUP entries (see previous section)

Verify the “true” location of the Citrix ICA client as “seen” by the EOLUP client. This can be done by
comparing the client directory path to the path specified in:

HKEY_CLASSES_ROOT\WinFramelCA\Shel\Open\Command

Note: An interesting scenario often occurs when more than one version of the Citrix ICA client
software (i.e., full PN, Web client, PN Agent) exist on the client PC. For example, if both the full PN
client and Web client were installed (in this order), installing the EOLUP client will only modify the
Web client installation. As such, launching ICA connections using the full PN client will not initialize
the EOLUP client. This is the case because the ICA file type is associated with the most recently
installed ICA client, which, in this case, is the Web client. Should more than one version of the ICA



client be required, Emergent OnLine recommends that the EOLUP-enabled versions of the desired
ICA clients be downloaded and installed from http://www.99point9.com.

For RDP support, verify that the EOLUP is installed to a Windows 2000 server, not WTS 4.0
(unsupported). Also, verify that the installed RDP client is version 5.0 (or above), and that the
Universal Printer virtual channel registry entries exist (see above). Although RDP support is only
available for Windows 2000 servers, client platforms supported include Win9x/Me, NT 4.0, Win2K,
and WinXP.



Using EOL Universal Printer™ with the TSAC

Organizations that rely on the Terminal Services Advanced Client (TSAC) to Web-enable the delivery of
server-based applications can easily UP-enable their Terminal Services implementations. To accomplish
this, edit the connection page of your Terminal Services Web application on your Web server and use the
PluginDlls property of the "Advanced" settings interface to specify the vdrdpup.dll virtual channel driver. For
illustration purposes, a sample Connect.asp file is shown below. The UP-enabling statement is outlined in

oversized bold:

<htmlI>

<head>

<title> Terminal Services Connection to <%Response.Write Request.QueryString("Server")%></title>
</head>

<body>

<script language="vbscript" >

<l--

const FullScreenWarnTxtl = "Your current security settings do not allow automatically switching to fullscreen mode.
const FullScreenWarnTxt2 = "You can use ctrl-alt-pause to toggle your terminal services session to fullscreen mode
const FullScreenTitleTxt = "Terminal Services Connection "

Const ErrMsgText = "Error connecting to terminal server: "

sub window_onLoad()
If not "<%Response.Write Request.QueryString("Server")%>" = " then
srvName = "<%Response.Write Request.QueryString("'Server")%>"

else
srvName = Document.location.hostname
end if
MsTsc.Server = srvName
Document.all.sryNameField.innerHtml = sryName
MsTsc.Domain = "<%Response.Write Request.QueryString("Domain™)%>"
MsTsc.UserName = "<%Response.Write Request.QueryString("UserName")%>"

MsTsc.AdvancedSettings.PluginDlls = "vdrdpup.dll*
if "<% Response.Write Request.QueryString("FS") %>" = "1" then
if MsTsc.SecuredSettingsEnabled then
MsTsc.SecuredSettings.FullScreen = "<% Response.Write Request.QueryString("FS") %>" = "1"
else
msgbox (FullScreenWarnTxtl & vbCrLf & FullScreenWarnTxt2 )
end if
end if

MsTsc.FullScreenTitle = FullScreenTitleTxt & "(" & "<%Response.Write Request.QueryString("Server)%>" & ")"
MsTsc.Connect()
end sub
>
</script>
<center>
<table>
<tr>
<OBJECT language="vbscript" ID="MsTsc"
CLASSID="CLSID:1fb464c8-09bb-4017-a2f5-eb742f04392f"



CODEBASE="mstscax.cab#version=5,0,2221,1"
WIDTH=<% resWidth = Request.QueryString("rw")
if resWidth < 200 or resWidth > 1600 then
resWidth = 800
end if
Response.Write resWidth %>
HEIGHT=<% resHeight = Request.QueryString("rH")
if resHeight < 200 or resHeight > 1200 then
resHeight = 600
end if
Response.Write resHeight %>>
</OBJECT>
</tr>
<tr>
<br>
<font size="1" color="#000000" face="Verdana, Arial, Helvetica">
You are logged in to <i><span id="srvNameField"></span></i></font><br>
</tr>

<script language="VBScript">
<l--
sub MsTsc_OnDisconnected(disconnectCode)
if not disconnectCode = 2 then
msgbox ErrMsgText & MsTsc.Server
end if
‘redirect back to login page
Window.Navigate("default.htm™)
end sub
->
</script>
</table>
</center>
</body>
</html>



Available EOL Universal Printer™ Client Bundles

EOLUPCLI.EXE: EOLUP client (ver. 3.0) w/built-in PDF viewer (no Adobe Acrobat Reader required).
EOLUPCLI_SILENT.EXE: Same as EOLUPCLI.EXE, but installs silently.

EOLUPCLI_ICA32.EXE: ICA Full PN client (ver. 6.30.1050) + EOLUP client (ver. 3.0). This will install the
ICA client and the EOLUP client, respectively.

EOLUPCLI_ICA32A.EXE: ICA PN Agent (ver. 6.30.1050) + EOLUP client (ver. 3.0). This will install the
ICA client and the EOLUP client, respectively.

EOLUPCLI_ICA32T.EXE: ICA Web client (ver. 6.30.1050) + EOLUP client (ver. 3.0). This will install the
ICA client and the EOLUP client, respectively.

EOLUPCLI.CAB: Cab-based EOLUP client (ver. 3.0).



Webh-Based EOL Universal Printer™ Client Installation

The UP client delivery can be Web-enabled in two ways:

ICA/EOLUP Client Bundles

This method allows organizations with NFuse-enabled MetaFrame systems to deliver both the ICA and UP
clients as a single download for first-time users, as well as users with outdated ICA clients. Implement this
method by replacing ica32.exe, ica32t.exe, and ica32a.exe in the NFuse server’s Inetpub\wwwroot\
CitrixX\ICAWEB\EN\ica32 with the UP-bundled equivalent files downloadable from http://www.99point9.com.
Specifically, download and rename the following files as follows:

EOLUPCLI_ICA32.EXE: rename to ICA32.EXE
EOLUPCLI_ICA32A.EXE: rename to ICA32A.EXE
EOLUPCLI_ICA32T.EXE: rename to ICA32T.EXE

Finally, copy the renamed files to Inetpub\wwwroot\CitrixX\ICAWEB\EN\ica32 overwriting the original files.

CAB-Based Delivery

This method enables the auto-downloading of the UP client to first-time users. Implement this method by
downloading the CAB version of the UP client, eolupcli.cab, from http://www.99point9.com, and copy it to
the Web server. Finally, add the following object tag to the Web page. Below is a sample HTML file. The

UP-enabling lines are outlined in oversized bold:

<HTML>
<HEAD></HEAD>

<OBJECT CLASSID="clsid:240EEE8D-91DB-4D74-A87E-671026601333"
CODEBASE="eolupcli.cab#version=3,0,0,0">

</OBJECT>

<BODY>

<H1>This page auto-downloads the UP client</H1>
</BODY>

</HTML>

Below is a UP-enabled version of Default.htm that the TSAC installation copies to the Web server:

<html>

<head>

<titte>Connect to Terminal Server<ftitle>

<style type="text/css" media="screen">

p { color:"#000000"; font-family: "Verdana, Arial, Helvetica"; font-size:"65%"}

hl { font-size: 100%; font-family: verdana, arial, helvetica; font-weight: bold;
margin-top: Oem;}



p.indent { margin-left: 3em; margin-top: .5em; line-height: 1.25em; margin-bottom: .2em; margin-right: 1em;}
.button {

FONT-FAMILY: Verdana, Helvetica, Arial, San-Serif;

font-weight:normal;

font-size:70%;

color:#000000;

background-color:#ffffff;

border-color:#6699ff;

margin-top:6pt;

margin-left: .5em;

}

.topspace {margin-top: .08em; }
</style>

</head>

<OBJECT CLASSID="clsid:240EEE8D-91DB-4D74-A87E-671026601333"
CODEBASE="eolupcli.cab#version=3,0,0,0">
</OBJECT>

<body bgcolor="#ffffff">
<script language="vbscript">
sub checkClick
if Document.all.Check1.Checked then
Document.all.tableLogonlinfo.style.display =
Document.all.editUserName.Disabled = false
Document.all.editDomain.Disabled = false
else
Document.all.tableLogonlinfo.style.display = "none"
Document.all.editUserName.Disabled = true
Document.all.editDomain.Disabled = true
end if
end sub

sub btnLogin
'Create connection URL and redirect to login page
conUrl = "connect.asp"

'server
if not Document.all.Server.value = " then

conUrl = conUrl + "?Server=" & Document.all.Server.value & "&"
else

conUrl = conUrl + "?Server=" & Document.location.hostname & "&"
end if

bAutoLogon = FALSE

if Document.all.CheckBoxAutoLogon.checked then
bAutoLogon = TRUE

end if

if bAutoLogon then
conUrl = conUrl + "UserName=" & Document.all.UserName.Value & "&"
conUrl = conUrl + "Domain=" & Document.all. Domain.Value & "&"

end if



‘resolution width-height
select case document.all.comboResolution.value
case "1"

conUrl = conUrl + "FS="& 1 & "&"

resWidth = screen.width

resHeight = screen.height

case "2"
resWidth = "640"
resHeight = "480"
case "3"
resWidth ="800"
resHeight = "600"
case "4"
resWidth ="1024"
resHeight = "768"
case "5"

resWidth ="1280"

resHeight = "1024"
case "6"

resWidth ="1600"

resHeight = "1200"
end select

conUrl = conUrl + "rW=" & resWidth & "&"
conUrl = conUrl + "rH=" & resHeight & "&"
'go to the login page
Window.Navigate(conUrl)

end sub

</script>

<l--
>

<a href="http://www.microsoft.com/windows2000"><img border="0" src="win2000l.gif" align="left" alt="Windows2000 logo"
width="198" height="124"></a><a href="http://www.microsoft.com/windows2000"><img border="0" src="win2000r.gif"
align="top" width="253" height="76" alt="Windows2000 logo"></a><br>

<h1>Terminal Services Web Connection</h1>

<br>

<table border="0" width="640" cellspacing="0" cellpadding=0 style="margin-top: -1em;">
<!-- Graphic bar row -->
<tr>
<td width="50%"></td>
<td colspan=3 align="left" valign="middle"><img src="bluebarh.gif" alt="blue bar graphic" width="325" height="8"></td>
</tr>
<I--Row 1 -->
<tr>
<!I-- Column 1 spans 4 rows -->
<td valign="top" width="50% "rowspan=4>
<p class=indent>Type the name of the Terminal server you want to use, select the screen size for your connection, and
then click <b>Connect</b>.</p>
<p class=indent>When the connection page opens, you can add it to your Favorites for easy connection to the same
Terminal server.</p>
</td>



<l-- Column 2 spans 4 rows-->
<td rowspan=4 valign="top" align="Ileft"><img src="bluebarv.gif" alt="blue bar graphic" border=0 width="8" height="330">
</td>

<l-- Column 3 -->
<td width="10%" valign="middle">
<label accessKey="S" for="editServer">
<br><p align="right">&nbsp;<u>S</u>erver:</label></p>

</td>

<l-- Column 4 -->
<td width="40%" valign="bottom">
<br>&nbsp;&nbsp;<input type="text" name="Server" size="41" id="editServer">

</td>
</tr>
<l-- Row 2 -->
<tr>
<l-- Column 3 -->
<td valign="middle">
<p align="right"><label accessKey="7" for="comboRes" class="sizespace">Si<u>z</u>e:</p></td>
<!-- Column 4 -->
<td valign="bottom">&nbsp;&nbsp;<select size="1" name="comboResolution" id=comboRes class="topspace">
<option selected value="1">Full-screen</option>
<option value="2">640 by 480</option>
<option value="3">800 by 600</option>
<option value="4">1024 by 768</option>
<option value="5">1280 by 1024</option>
<option value="6">1600 by 1200</option>
</select> </label>
</td>
</tr>
<!-- Row 3 -->
<tr>
<!-- Column 3 -->
<td></td>
<l-- Column 4 -->
<td align="bottom">
<p class=topspace>&nbsp;<input type="checkbox" name="CheckBoxAutoLogon" ID=Checkl value="OFF" onclick =
"checkClick"><label for="Check1" accesskey="I">Send <u>I</u>ogon information for this connection&nbsp;</label><br>

<span ID="tableLogonInfo" style="display: none">

<p align="right" class=topspace>
<br>
<u>U</u>ser&nbsp;name:
<label accessKey="U" for="editUserName"><input type="text" name="UserName" id=editUserName
size="25"></label><br>
<u>D</u>omain:
<label accessKey="D" for="editDomain">
<input type="text" name="Domain" id=editDomain size="25"></label></p></span>
<input type="submit" value="Connect" name="ButtonLogin" OnClick=BtnLogin class="button">
</td>
</tr>



<!--Row 4 -->

<tr>

<!-- Column 3 -->

<td height="215">&nbsp;</td>
<!-- Column 4 -->
<td>&nbsp;</td>

</tr>

</table>

</body>
</html|>



Licensing EOL Universal Printer™

Upon installing EOLUP 3.0 onto a Terminal Services server, a 30-day trial license is automatically granted.
Beyond the trial period, users who attempt to print using EOLUP will be notified of the license expiration.
As such, the EOLUP will cease to function until a permanent license has been acquired. You may
purchase a permanent license by contacting Emergent OnLine as follows:

Phone: 703.709.9210
Fax: 703.709.9219

Email: sales@go-eol.com
Web: www.go-eol.com

EOLUP 3.0 is licensed on a per Terminal Services server basis. Simply invoke the THINssentials Service
Manager from Start > Programs > EOL THINssentials as shown in figure 23. You must submit the MAC
address of your server as reported by the THINssentials Service Manager to obtain a permanent license.

4 EOL THIMssentials Service Managerﬁi

Server Mame:

Service Mame: IEEIL Universal Printer =]

TCF Part: I

MAC Address: |IZIIII-3III-F1 101712

Licenze Kew: |I]2I:I DenwR 0b201 dvb

Days Remaining: IF'ermanent Licenze

Heztore Lizenze Spply

Service Mame: EOL Univerzal Printer

Service Statuz: The Service iz Bunning
Service Exe: C:ANWINNT Y apstemd2enlup exe
Service Account: LocalSystem

Start Senvice Stop Service Refresh

Inztall Service Delete Service Cloze

Figure 23 - EOL THINssentials™ Service Manager

When installed onto the designated print servers, EOLUP 3.0 does not require any licensing. It may be
installed onto as many print servers as desired.



Upgrading from Previous Versions

If upgrading from EOL Universal Printer™ version 1.x or 2., installing version 3.x will invalidate the license
key. Customers who have purchased their license(s) after September 9™, 2001 are eligible for a free
upgrade to version 3.x. The new license key replacements may be automatically generated by visiting
http://www.99point9.com.




Upgrade Protection and Technical Support

Emergent OnLine offers free software maintenance and technical support for a period of one (1) year from
the date of purchase. Following the first year, the maintenance and support option can be renewed at the
cost of 20 percent of the product’s list price.

For additional information, please contact Emergent OnLine’s sales and technical support as follows:

Phone: 703-709-9210

Technical Support E-mail: support@go-eol.com
Sales Support: sales@go-eol.com

Web site: www.99point9.com




